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This document provides complementary or late-breaking
information to supplement the Microsoft Windows Millennium
(Windows Me) documentation.

HOW TO USE THIS DOCUMENT

To view General.txt on-screen in Notepad, maximize
the Notepad window.

To print General.txt, open it in Notepad or another
word processor, and then on the File menu, click Print.
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STARTUP PROBLEMS

System Detection Error - BIOS Could Lead to Data Loss

If your computer displays the following message:
System Detection

Your computer uses a BIOS that could lead
to data loss if you run Windows Me.



Please update the BIOS before installing
Windows Me. For more information,
contact your computer manufacturer.

You can still install Windows Me by
following the procedure below.

NOTE: Microsoft takes no responsibility for any damage
that may result from this operation.

1. Copy the contents of the Windows Me
CD-ROM to your hard disk.

2. At the Command prompt, type:
extract precopy2.cab msdet.inf

3. At the command prompt, type:
edit msdet.inf

4. On the Search menu, select Find.

5. In the Find What box, type:
[BadDSBios]

6. Select Find Now.

7. Insert a semicolon before each of the two
lines following the [BadDSBios] heading.

8. Save your changes, and then run Setup again.

APPLETS

HyperTerminal: Known Problems and General Information

- When it receives a file, HyperTerminal cannot determine
whether the disk is full.

- In File Transfer, HyperTerminal does not send files

with attributes marked as System or Hidden.

ScanDisk: Special Handling of Characters from Different
Code Pages

- If you have created or named files or folders while
using different code pages, ScanDisk may report errors
about these files or the folders they reside in. Open
the ScanDisk Advanced dialog box and make sure the check



box for Check files for invalid file names is cleared.
Turning off this option may inhibit the program's ability
to detect or repair seriously damaged folders.

LARGE DISK SUPPORT (FAT32)

Introduction

Windows Me includes support for an enhanced
version of the FAT file system, FAT32, that supports
drives up to 2 terabytes (approximately 2,000 GB). It
also allocates space on the drive in smaller units
(called clusters) than did earlier versions of FAT,
resulting in more efficient use of space on the drive.

This section addresses some of the known issues
with FAT32 and answers some of the questions you
might have.

Compatibility

FAT32 is designed to be fully compatible with

existing computers and programs designed to run

on earlier versions of MS-DOS and Windows. However,
some older disk utilities may need to be updated

in order to work with FAT32 drives. The system tools
contained with Windows Me, including

ScanDisk, Backup, and Disk Defragmenter, fully support
FAT32 drives. FAT32 drives cannot be compressed by
using DriveSpace, however.

In addition, operating systems other than

Windows 95 version 4.00.950 B, Windows 98, or
Windows 2000 are unable to access information

stored on FAT32 drives. This includes the original
version of Windows 95, Windows NT version 4.0 and
earlier, and previous versions of MS-DOS and Windows.

Windows Me does support accessing FAT32

drives in MS-DOS mode. In addition, FAT32 drives can be
shared over a network and accessed by remote computers in
the same way as older-style FAT drives, even if the

remote computers don't support FAT32.

Known Problems

Running Interlink on a FAT32 drive

If you are running Interlink as a server on a



FAT32 drive, all connections and inquiries (such
as DIR) result in the following error message:
"File allocations table bad, Drive X." Also, the
Interlink "manager" shows the incorrect total
drive size.

This problem does not occur on FAT16 drives. To

gain access to your FAT32 server, start your
computer in protect mode with Interlink running.

Incorrect Free Disk Space Reported by Programs

Programs not developed specifically for Windows Me
might be unable to report free space accurately on
large hard disks that use FAT32. Most older
applications cannot display free or total disk

space of more than 2 GB. These older programs will
typically only report up to approximately 2 GB free,
when more disk space is available. When the free
disk space drops below 2 GB free, these programs
will report the free space correctly.

Ontrack Systems Disk Manager

If you use the Ontrack Systems Disk Manager
program on a computer with a FAT32 drive, there
might be a long pause when you start your computer.
It is also possible that the drive will be set to

run in compatibility mode. If you use version 7.0,
you can avoid this pause by using the /L=0 option
with Disk Manager:

1. Start your computer, and then run Disk Manager.

2. Click Maintenance, and then click Update
Dynamic Drive Overlay.

3. Add /L=0 to any other options that are
already present.

4. Save the settings, and then restart your computer.
If you are running an earlier version of Disk
Manager and you want to use FAT32, you should

update to version 7.04 or later and use the /L=0
switch.

V Communications System Commander

Versions 2.28 and earlier of V Communications
System Commander are incompatible with FAT32.



If your primary hard disk uses FAT32 exclusively,
obtain version 3 or later of System Commander.

lomega Jaz Tools May Be Incompatible with FAT32

If you format an lomega Jaz disk using FAT32,
you may need to obtain updated versions of the
Jaz tools. Older versions of the tools do not
support FAT32 Jaz disks. As a result, the eject,
write-protection, and password-protection options
will be disabled. Updated versions of these tools
that are compatible with FAT32 are available from
lomega. They are also available for download from
various online services.

Questions and Answers

How do | tell if a drive is a FAT32 drive?

In My Computer, right-click the icon that
represents your hard disk, and then click
Properties. On the General tab, your type
of drive is shown in the upper part of the
tab, by the label File system.

If you have a FAT 32 drive, File system: FAT32

is displayed. If you have a FAT 16 drive,
File system: FAT is displayed.

How do | enable FAT32?

If you obtained this version of Windows Me

with a new computer system, it may already be

using the FAT32 disk format. If not, or if

you add a new hard disk to your computer and

you want to use the FAT32 file system, use the

FDISK tool to create the disk partition as FAT32. (Note:
Backup any data on the drive before using the FDISK

tool to remove an existing partitions as all data currently
on the drive will be lost.) To do this, when you are prompted
to enable large disk support, choose Yes and any partition
created will be marked as FAT32.

Is FAT32 faster than earlier versions of FAT?

FAT32, in conjunction with Memory Manager
improvements and the application launch time



feature of Disk Defragmenter can significantly
improve your system performance.

However, FAT32 drives may be significantly slower
on disk-intensive operations when your computer

is running in MS-DOS mode or when you are running
Windows Me in safe mode. If you use

MS-DOS mode with FAT32 drives, you may find that
performance is improved significantly if you load

the Smart Drive disk-caching program.

DRIVERS

Windows Me supports EZ-Drive
through the protected-mode IDE driver.

Netgear FA310TX 4.02 Driver

Netgear FA310TX 4.02 drivers are provided on the CD in the following location:
x:\drivers\net\netgear (where x: is your CD-rom drive letter)

This driver will resolve certain shutdown issues. Please read the netgear.txt
provided in this directory on how to install the drivers.

PAN-EUROPEAN: KNOWN ISSUES

There are certain characters used within the Cyrillic
alphabet that cause problems when you use them in

file names. This problem is a translation issue and

is only seen in an MS-DOS window or within any process
that relies on MS-DOS. These characters are:

Small and Capital Belarussian/Ukrainian |

(Alt codes 179, 178)
Small Cyrillic letter JE (Alt code 188)
Small and Capital Cyrillic LJE (Alt codes 154, 138)
Small and Capital Cyrillic NJE (Alt codes 156, 140)
Small and Capital Cyrillic DZHE (Alt codes 159, 143)
Small and Capital Cyrillic DZE (Alt codes 190, 189)
Small and Capital Cyrillic GHE with Upturn

(Alt codes 180, 165)

If you save a file in a Windows application with a file
name that contains one of these characters, the file name
contains underline () characters instead of the one

you typed.

File names using these characters also cause problems
under the following conditions and should be avoided:



- When you try to copy or rename the file name in an
MS-DOS window using these characters.

- When you use these characters in a file name saved
on a network drive.

- When these characters are used in file names to
restore previously backed up images that are located
on a network drive.

This problem is intentionally there, due to the
differences between the Windows Code Page and the
OEM Code Page. This problem previously existed in
Windows 95 and is mentioned here for clarification
purposes.

Czech Microsoft Excel 97

Czech Microsoft Excel 97 will not run after you upgrade

to Windows Me, and will terminate with a

Lexikon (C:\PROGRAM FILES\MICROSOFT OFFICE\OFFICE\XL8805.DLL)
chybi nebo je poskozen message.

>>> To run the Czech Microsoft Excel 97:

1. Click Start, point to Programs, and then
click Windows Explorer.

2. Navigate to the
C:\PROGRAM FILES\MICROSOFT OFFICE\OFFICE directory.

3. Select the file XL8405.DLL and, on the Edit menu,
click Copy.

4. On the Edit menu, click Paste.

5. On the File menu, click Rename, type XL8805.DLL
and then press ENTER.

6. Close Windows Explorer.

When you start the Czech version of Microsoft
Excel 97, it should function correctly.

Extended (NLS) Character Support in
Hardware Profiles

Multiple hardware profiles can be loaded on a Windows
Millennium system using the Hardware Profile tab

in the System Properties dialog box. When you name the
profiles, do not use extended characters. Otherwise,

the text appears in the wrong font when the system
starts. Then you won't be able to read the Profile Name



in the Configuration Selection list during start up.

For example, the messages you see for the
Configuration Selection list would look similar
to those shown below.

Select A Hardware Configuration...
Windows was unable to determine your current Hardware
Configuration. Select one from the list.

<Text displayed in wrong font if extended
characters used>

<Okay>

Although you will be unable to read the text, you
can select the appropriate option from the list and the
system will continue if you know which choice you want.

This problem is intentionally there, due to the

differences between the Windows Code Page and the
OEM Code Page. This problem previously existed in
Windows 95 and in Windows 98 and is mentioned here for
clarification purposes.

NOTE: Review the Intl.txt file on your Windows Millennium
CD for more information about Pan-European regional settings.

USING ACCESSIBILITY SHORTCUTS IN HELP

The following keyboard shortcuts can be used for

navigation, selection, and other functions in

Windows Me online Help. Some of these

keyboard shortcuts are also applicable throughout

Windows Me. For more information about using Windows me
accessibility features, visit the

Microsoft Web site at http://www.microsoft.com/enable

ALT+SPACEBAR

Use this shortcut to display the System menu. Use
the arrow keys to choose a command, and then press
ENTER.

ALT+F4

Use this shortcut to close Help.

ALT+TAB



Use this shortcut to switch between Windows Help and
other open windows.

CTRL+C

Use this shortcut to copy selected text so that you
can paste it in another file using a text editor
such as Notepad.

CTRL+V

Use this shortcut to paste copied text into a file
by using a text editor such as Notepad.

CTRL+A

Use this shortcut to highlight the text in the
right pane.

SHIFT+F10

Use this shortcut to display the shortcut menu on
the Windows desktop.

TAB

Use this shortcut to move to topics in the table
of contents, index, search results, and all links
in the displayed topic.

BACKSPACE

Toggles the Back button.

ESC

Use this shortcut to close dialog boxes and menus
throughout Windows Me.

Use this shortcut throughout Windows Me
to execute the requested command, such as
opening a topic or displaying a list of topics.

UP ARROW/PAGE UP



Use this shortcut to move up one topic in the table
of contents, index, and search list if slider bar is available.

DOWN ARROW/PAGE DOWN

Use this shortcut to move down one topic in the
table of contents, index, and search list if slider bar is available.

Microsoft Magnifier

Microsoft Magnifier is intended to provide a minimum
level of functionality for users with slight visual
impairments. Most users with visual impairments will
need a magnification utility program with higher
functionality for daily use. For a list of Windows-based
magnification utilities, visit the following Web site:

http://www.microsoft.com/enable

Networks Not Supported in Windows Me

The following network systems are not supported in
Windows Me. These networks may work after

you upgrade to Windows Me, but Microsoft does
not guarantee that they will work correctly.

- Vines16: All versions earlier than 7.1

- Netware: Using Client for Microsoft Networks
connecting to server versions earlier than 3.11.

- Microsoft Netware Directory Services or NDS for connecting to

Non-Bindery Novell 4.x servers

- Client32: It is recommended that you use Client32
versions later than 2.2.

- Client 32 for DOS/Win31: All versions.

- VLM/NetX: Monolithic drivers (ipx.com)

- Lantastic16: All versions

- Lantastic32: All versions earlier than 7.0

- Pathworks16: Not supported

- Pathworks32: It is recommended that you use
Lantastic 7.0 or later.

- Backup Agents, Jetadmin Services: Versions shipped
with Windows 95.

- TCP: 16-bit stacks

NOTE: Non-WinSock2 TCP/IP stacks are only supported on

upgrades. These products do not function if installed
on Windows Me.

Processor Type Reported in System Control




Information reported in the System Control Panel reflects
the processor type being used by Windows, and is not a
guarantee of the actual make/type of processor installed
in your system. Newer processors that are released after
Windows Me may not be properly identified.

Samsung USB Keyboard with Hub

The hub on the Samsung USB keyboard does not always
identify itself correctly. When it identifies itself

as a self-powered device, it confuses the operating
system, causing odd behavior with the hub portion of

the keyboard. There is no workaround. Use low-powered
USB devices such as mouse and gaming devices or
self-powered devices with this keyboard.

Support for Lexmark MarkVision and Custom
Printer Drivers

Some early versions of MarkVision and the

Lexmark Custom Printer drivers are incompatible

with Windows Me. To avoid a problem

with your system, Windows Me disables

these components when you upgrade from Windows 95 if
you currently have LEXBCE version 1.03 or earlier.

If you have a version later than LEXBCE 1.03, Lexmark
software works correctly on Windows Me.

To determine which version of LEXBCE you have,
use Windows Explorer. Go to your \Windows\System
subdirectory. Right-click LEXBCE.DLL, and then
click Properties. Click the Version tab, and then
locate the File version information. If needed,

you can obtain a newer version of the software

from the Lexmark Technical Support Center or on
the World Wide Web at

http://www.lexmark.com.

Vines16

The Vines16 install program behaves the same in
Windows Me as it does in Windows 95.

When the install program runs, users must first install
the client, and then after Windows restarts, cancel the
installation program. This completes the Vines16
installation.

During the cancel portion of the Vines16 install
program, the Vines file WNEWREV.EXE occasionally
causes a GPF. The machine hangs sometimes with video



corruption. When this happens, the Shell has been
reset to shell=z:\wnewrev.exe. After Windows 98
restarts, it will continuously restart. To fix this,

edit C:\Windows\System.ini and set the
shell=z:\wnewrev.exe to shell=explorer.exe.

If the Vines interface does not function, for example,

if you cannot map a network driver from within Windows
or view previously mapped Vines drives, the path may be
lost or corrupt. You must have Z:\ set to the end of the
path. This can be accomplished in either the Autoexec.bat
or the Vines Login script. You can also have the Vines
Administrator place the path in the Vines login script

for you.

On rare occasions, during the Vines16 client install
program, the following error occurs:

"ver.dll file in use, click okay" which results in an
endless loop with the Vines16 client install program.
The workaround is:

1. Shut down your machine.

2. Restart your machine in Safe Mode, Command
Prompt Only.

3. Edit C:\Windows\System.ini so shell=explorer.exe

4. Edit C:\Windows\Vines.ini to include dontcopy=1 in
the [newrev] section

5. Restart your system.

If the Vines16 client install program runs spontaneously
or runs every time the system is restarted, edit
C:\Windows\Vines.ini to include dontcopy=1 in the
[newrev] section.

Always click NO when the Vines16 install program
prompts you to overwrite ver.dll. Overwriting ver.dll
causes a fault with the powrprf.dll and major loss
of Windows functionality, like printing and Control
Panel functions. The workaround is to re-extract
ver.dll from your Windows Me source

media to C:\Windows and C:\Windows\System.

Windows Device Manager Video Capture Devices
and Video for Windows Applications

Applications that use the Video for Windows 1.1 (VFW)
interfaces also use drivers that conform to the VW 1.1
driver interfaces. However, with the new Windows Device
Manager (WDM) video capture interfaces in Windows 98
Second Edition, applications can no longer use the VW
interfaces to directly communicate with these WDM-based
devices. Windows Me includes a software

layer that translates VW 1.1 interfaces into WDM video
capture interfaces. This translation software works only



for video capture devices on external busses (USB and 1394)
in Windows Me.

Analog capture devices (such as PCI cards with video
decoder chips that use WDM drivers) cannot use this
translation software. The original VfW drivers for these
analog capture devices will continue to work but they
cannot be used in combination with the newer WDM drivers.
An updated version of this translation software is

available at http://www.microsoft.com/support.

For information, search for "Video for Windows WDM".

Digital IDs

If you uninstall Windows Me, any certificates
you obtained after installation will be removed.

To avoid this, you can contact the certificate provider to
obtain another certificate, or you can save the certificate

and use it with Internet Explorer version 4.0 or later in
Windows 95 and Windows 98, or Windows98 SE with Internet
Explorer 5.0.

To save a certificate before you uninstall Windows:

1. In Internet Explorer, click Tools, click Internet Options,
and then click the Content tab.

2. Click Certificates, and then click Export.

LOGITECH WHEEL MOUSE

Logitech Wheel Mouse running Logitech MouseWare versions
older than 8.35 will fail when upgrading from Windows 98

to Windows ME. In order to continue full functionality of

your Logitech Wheel Mouse, please update your Logitech
MouseWare to the latest version available on the Logitech website.

UNDOCKING INSTRUCTIONS

Millennium supports two methods of undocking; Warm and Hot. "Warm" undocking is
described as the system entering standby before being undocked from the docking
station. "Hot" undocking is described as the system being undocked from the
docking station while it is fully powered. Whether or not a laptop system

supports Warm or Hot undocking depends on the capabilities of the laptop itself

as designed by the manufacturer.

To undock a laptop, Microsoft Millennium officially supports the following
method: From the Start menu, choose "EJECT".

If the laptop system supports "Warm" undocking, the system will enter standby
before the laptop is required to be removed from the dock. This may occur
automatically or the user may be required to manually eject the system from the
dock after it enters standby. The method of removing the system from the dock
is dependant on the design of the system by the Manufacturer.



If the laptop system supports "Hot" undocking, the system will automatically

eject from the dock, or the user will be prompted with the following message:
"Windows told the computer to undock. If you need to eject the system by hand,
please do so now." The method of removing the system from the dock is dependant
on the design of the system by the Manufacturer.



